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Introduction
This GRAPHISOFT Archicad Project Audit Report contains evaluations of different aspect of your Archicad Model,
covering 115 checked items. These items are evaluated along the lines of 3 main categories: Performance, Structure,
and BIM Essentials.
‘Performance’ takes into account things about the project that could affect the required processing power, thus
making Archicad run less efficiently than it could, and also some organizational and workflow aspects, that might
have an effect on the speed of how fast you can work.
‘Structure’ refers to how well the project and its attributes and settings are organized. An organized, well-structured
project allows users to work more efficiently, and understand the workflows faster and better.
‘BIM Essentials’ are the basic tools and rules required to build up a project along the principles of Building
Information Modeling. Mastery of these are all necessary to maintain a Model that can be the basis for good model
exchange practices.
The report is broken down into 7 Sections, grouped by theme, to help you see what main fields may need improving
in your project. After each section there is a summary of that section, and at the end of the entire report there is a
Summary of all 115 items divided by all 7 sections and all 3 categories.
Please keep in mind that this report is solely based on the Archicad Project File provided, by no means it is capable
of evaluating how you work. The results here in some cases may not be objective. They are only meant to help you
find areas that could be improved by trainings and consultation.
This report is confidential and only intended for the recipient(s) named on the front cover. Unauthorized reproduction is strictly
forbidden.
Disclaimer: Information Only. Use at your own risk. GRAPHISOFT will accept no liability for any problems encountered as a result
of using this file or any Archicad related data made as suggested in this document.
This document is copyright © GRAPHISOFT. 2020 All rights reserved worldwide.

Scoring
You get a score for each checked item in this report. This score can be
Scoring Panels:
anything from 0–3, or “N/A” in case it is not applicable to your project. These
Performance
scores will be placed in a Scoring Panel next to each item in the report.
Structure
Since each item might affect different aspects of your model, the score will not
BIM Essentials
necessarily apply to each of the three categories. You will see the score next to
Impact Multiplier
the name of the category it applies to, and you will see “—” next to the
categories it doesn’t apply to.
Each item also gets an Impact Multiplier. This number can be anything between Possible Scores:
1–5, and signifies the Impact it can have on your project. In the final results and
Good
summaries, the results to each question will be weighed by these multipliers, so
Average
more serious issues will have more effect on your final result.
Needs Improvement
On the right side of each question’s Scoring Panel, you can see a colored bar.
Not used at all
This bar gets its color based on the score. It is meant to make it easier for you
Not Applicable
to spot the problematic items when quickly scrolling through the report.
After each section, you will see a summary where all the scores from the
current section will be summed, and you can see some notes made by the
auditor (if any). In the Summary Section, you will see your final score based on
all items in the entire report.
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3/3
3/3
—
5

3/3
2/3
1/3
0/3
N/A

0. Audit Details
Audit Details
Date of Audit:
Archicad Project Audit version:
Auditor's name:
Audit Provided by:
Archicad version used for Auditing:
Report Language:

August 2, 2021
v2021
Kovács, Dániel Alexander
GRAPHISOFT HQ
Archicad 24 INT 5004
English (International)

Project Details
Project's name:
Project stage:
Archicad version:
PLA file name:
PLA file size:
3rd Party Add-ons used:
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S-Office – Sample Project
Design Development
Archicad 24 INT 3008
GRAPHISOFT_Archicad_Sample_Project-S-Office_v1.2_AC24Modified.pla
758 MB
No 3rd Party Add-ons.

1. Library Management
Libraries contribute to the size and speed of a project. Large and complex library parts, missing objects, duplicate
objects, multiple libraries, excessive library parts, all contribute to the performance of the project. A three library
system is recommended: the current Archicad Library for standard objects, an Office Library for objects specific to
your company and a project-specific Library for objects unique to each project only. And any Migration libraries if
the project has been migrated. Also many Archicad objects are scale dependent. These are not covered in the
checkup but please be aware of this and edit the settings of each object if necessary. Use the Embedded Library
with caution: it should not contain too many elements.

1.1. Embedded Library
Number of items in the Embedded Library: 31
Consider tidying the Embedded Library up by organizing items into folders, for the sake
of being tidy. No significant issues will arise if you choose not to.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85477/

Performance

2/3

Structure

2/3

BIM Essentials

2/3

Impact Multiplier

5

Performance

1/3

Structure

1/3

BIM Essentials

1/3

Impact Multiplier

3

1.2. IFC Libraries
IFC Library Container Files (.LCF):

1

IFC Folders:
2
All or most of your IFC libraries are stored in the project folder based. Enumeration of
these libraries takes more time and can cause serious performance issues. Save these
libraries as .LCF to gain better performance and more organized project.
Reference: https://helpcenter.graphisoft.com/knowledgebase/25729/

1.3. Images over 1MB
Number of image files over 1 MB: 3
There are no or few images over 1MB. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85477/
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Performance

3/3

Structure

3/3

BIM Essentials

—

Impact Multiplier

3

1.4. Linked Libraries
Number of Linked & BIMcloud libraries: 13
There are more than 6 Linked & BIMcloud libraries loaded in the project. These should
be kept to a minimum as per the three library system as mentioned in the section
header. If you regularly use any add-on libraries, surface catalog libraries, etc., it is a
good idea to load them individually so they can be updated individually. If there are any
extra libraries loaded in the project that are not shown below, you can safely remove
them. We recommend to always link at least the default Archicad library.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85478/

Performance

1/3

Structure

1/3

BIM Essentials

—

Impact Multiplier

5

1.5 Large Point Cloud files in the Library
Size of Point Clouds in MBs: 153 MB
The Point Cloud files in total are less than 200MB in size, which is a good size. It is
recommended to keep Point Cloud file sizes to a minimum as large Point Clouds can
slow down 3D navigation, affect library loading times and increase file sizes. Make sure
to remove the Point Clouds from the project, if no longer needed.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85653/

Performance

3/3

Structure

3/3

BIM Essentials

3/3

Impact Multiplier

3

1.6 Missing Library Parts
Number of Missing Library Parts: 7
This number of missing library parts is relatively low. These may consist of images and/or
objects. Consider modifying, replacing or deleting these parts or the Surfaces that
reference the image files. It's a good rule of thumb to never have the library loading
report appear with Missing Object errors.
Reference: https://helpcenter.graphisoft.com/user-guide/127921
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Performance

2/3

Structure

2/3

BIM Essentials

—

Impact Multiplier

3

1.7. Duplicated Library Parts
Number of Duplicated Library Parts: 1
This number of duplicated library parts is relatively low. Consider removing all duplicates.
Duplicates can be identified by selecting each library listed under the 'Library' with
'Duplicated Library Parts', then clicking the blue 'Information' button in the bottom right
corner. In the next dialog change the flyout to 'List of All Duplicates'. Then remove those
duplicates from one of the libraries, via your operating system and reload the libraries.
It's a good rule of thumb to never have the library loading report appear with Duplicate
errors.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85653/
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Performance

2/3

Structure

2/3

BIM Essentials

—

Impact Multiplier

1

Library Management Potential

Auditor Notes
No Additional Notes.
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2. Project Management
The way the model and annotation is managed can greatly affect the size and speed of a project. 2D & 3D elements
and trace references can all slow down performance and add to file bloat if not managed correctly.

2.1. Solid Element Operations
Number of Solid Element Operations: 128

Performance

2/3

Number of Target Elements:

Structure

2/3

BIM Essentials

2/3

49

Number of Operator Elements:
45
The project contains a considerable amount of Solid Element Operations, but be careful
adding many more. Too many SEOs can slow Archicad down considerably. Consider if
these SEOs can be handled with polygon editing, priority based connections or trims.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85547/

Impact Multiplier

5

2.2. Simultaneously open tabs
Number of tabs open simultaneously: 15
Too many tabs open simultaneously can start to bog down the project. The highest
optimal number is 6 or 7. Consider closing any unnecessary tabs and/or changing your
work environment to open tabs in existing tabs, via the User Preferences Schemes>
More Options section.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85468

Performance

2/3

Structure

—

BIM Essentials

—

Impact Multiplier

1

2.3. Simultaneously active Trace References
Number of Trace References active simultaneously: 5
The project has a manageable number of Trace References enabled. No action needs
to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85501/

Performance

3/3

Structure

3/3

BIM Essentials

—

Impact Multiplier

3

2.4. Trace Referencing Views & Layouts
Number of Trace References using Views or Layouts as Source: 1
Trace referencing views from the view map or layouts from the layout book as opposed
to viewpoints from the project map can start to bog down Archicad if there are too many,
as Archicad needs to calculate all the view settings for each. Trace referencing Sections,
Elevations, Layouts, etc. that need updating can also cause slowness. There are very
few or no trace referenced viewpoints, views and layouts. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128016/

Performance

3/3

Structure

—

BIM Essentials

—

Impact Multiplier

3

2.5. Number of Elements
Total number of all (2D & 3D) Elements in the Entire Project: 11 170
The project has 100 000 elements or less which is a manageable amount. No action
needs to be taken.
Note: This number doesn't include elements on the Archicad Layer.
Reference: https://helpcenter.graphisoft.com/user-guide/128013/
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Performance

3/3

Structure

—

BIM Essentials

—

Impact Multiplier

3

2.6. Utilizing Archicad’s 3D modeling capabilities
Number of 3D Elements in the 3D Model Space & Floor Plans:

10 120

Number of 2D Elements in Floor Plans:

151

Number of all (2D & 3D) Elements in the 3D Model Space & Floor Plans:

10 271

Percentage of 3D Elements out of all Elements in the 3D Model Space:
99%
The project has most or all of the building elements created in 3D. No action needs to
be taken.
Reference: https://helpcenter.graphisoft.com/knowledgebase/25478/

Performance

3/3

Structure

—

BIM Essentials

3/3

Impact Multiplier

1

2.7. Number of Groups
Number of Groups in 3D Model Space & Floor Plans: 145
The project has over 100 groups which could start to slow down Archicad. Consider
reducing this to a more manageable amount (under 100).
Reference: https://helpcenter.graphisoft.com/user-guide/128013/

Performance

2/3

Structure

—

BIM Essentials

—

Impact Multiplier

3

2.8. Sun Shadows in 3D Styles
Number of 3D Styles that have Sun Shadows turned on:

5

Performance

2/3

Total number of 3D Styles in the Project:

13

Structure

—

BIM Essentials

—

Impact Multiplier

3

Percentage of 3D Styles with Sun Shadows out of all 3D Styles: 38%
The project has some 3D Styles with Sun Shadows enabled. These can affect
performance. Consider the need for these 3D Styles, especially if they are assigned to
Views.
Reference: https://helpcenter.graphisoft.com/user-guide/128998/

2.9. Errors in 3D
Number of Errors in Session Report: 2
Archicad reports up to 10 errors when opening the 3D window. Consider finding these
corrupt elements using Find & Select and modifying or replacing them. Turning on
'Interrupt with error messages' and 'Write Report' in the Model Rebuild Options of the
Work Environment profile will aid with this, along with using the Element ID Manager if
there are multiple element with identical IDs.
Reference: https://helpcenter.graphisoft.com/userguide/128945/#XREF_78293_Session_Report
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Performance

2/3

Structure

2/3

BIM Essentials

—

Impact Multiplier

1

2.10. Number of Polygons
Number of Polygons in the Project: 2 134 404
The project contains less than 5 million polygons. With this many polygons, Archicad
should function smoothly.
Keep an eye on the polygon count, and try to keep it as low as possible to avoid
performance issues in the future. You can try to lower the detail level of elements in the
Model View Options whenever you are not working on Visualizations, delete any
elements you are not using anymore, and turn off layers that you do not need while
editing certain aspects of the model. Note that downloaded objects usually have a high
polygon count.
Reference: https://helpcenter.graphisoft.com/knowledgebase/25868/

Performance

2/3

Structure

2/3

BIM Essentials

—

Impact Multiplier

5

2.11. Number of Duplicates
Number of Duplicated elements in the Entire Project: 6
The project contains very few or no duplicates.
You can make sure that it stays like this, if you run the Check Duplicates command to
track down duplicates. This command is part of the GRAPHISOFT Goodies Add-on
package. You can find out more about it on the page linked below.
Reference: https://helpcenter.graphisoft.com/knowledgebase/64529/

Performance

3/3

Structure

3/3

BIM Essentials

3/3

Impact Multiplier

3

2.12. Model extents and position
Model's distance from the Archicad Project Origin: 0.00 m
The model is close to the Archicad Origin and no elements are out of bounds. No action
needs to be taken.
Reference: https://helpcenter.graphisoft.com/knowledgebase/25447/
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Performance

3/3

Structure

3/3

BIM Essentials

3/3

Impact Multiplier

3

2.13 Model Accuracy
Amount of inaccurate perpendicular wall connections: None
All the walls in all stories are straight and square. No action needs to be taken.
Reference: https://bimcomponents.com/LCF/Details/6119

Performance

3/3

Structure

3/3

BIM Essentials

3/3

Impact Multiplier

3

2.14. 2D Linework Consolidation (in Floor Plans)
Number of deleted duplicates:

0

Performance

3/3

Number of merged connecting lines:

0

Structure

3/3

Number of merged overlapping lines:

0

BIM Essentials

—

Number of deleted lines overlapped by identical lines:

0

Impact Multiplier

3

Number of deleted lines covered by solid lines:

0

Number of deleted lines overlapped by different type lines:

0

Number of adjusted lines:

0

Number of split lines:

0

Total number of affected lines:
0
The plan views required no, or minimal linework consolidation. No action needs to be
taken, although there may also be linework consolidation required in other viewpoints.
Reference: https://helpcenter.graphisoft.com/user-guide/128023/

2.15. 2D Fill Consolidation (in Floor Plans)
Number of fills before consolidation:

7

Number of fills after consolidation:
2
The plan views required no, or minimal fill consolidation. No action needs to be taken,
although there may be fill consolidation required in other viewpoints.
Reference: https://helpcenter.graphisoft.com/user-guide/128023/
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Performance

3/3

Structure

3/3

BIM Essentials

—

Impact Multiplier

3

Project Management Potential

Auditor Notes
No Additional Notes.
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3. Attribute Management
Attribute Management does not greatly affect the performance of the project, but it is very important to have a tight
structure especially when collaborating or using hotlinked modules between projects. Attributes can be viewed via
the Attribute Manager and should be thoughtfully assigned a name and ID. Some special attributes provided by
GRAPHISOFT, such as pens and fills, should not be changed from their original otherwise elements may not appear
correctly.

3.1. Attributes in use
Number of Attributes in use in the Project:

353

Performance

3/3

Total number of Attributes in the Project:

587

Structure

3/3

Percentage of Attributes in use out of total: 60%
BIM Essentials
The Layers, Line Types, Fill Types, Composite Structures, Profiles, Surfaces, Building
Impact Multiplier
Materials, and Zone Categories in the project are at a high ratio of being used. An
excessive amount of attributes can increase the size of the project and add unnecessary
complexity. It is important to keep attributes that may be required in the future, but
consider removing redundant attributes if it gets out of hand.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85469/

—
3

3.2. Structuring of Layers
Layers do follow a consistent naming convention and there are some external layers,
such as those from Consultants or XREFs. Consider modifying the names so that they
read the same.
Reference: https://helpcenter.graphisoft.com/user-guide/127877/

Performance

—

Structure

2/3

BIM Essentials

2/3

Impact Multiplier

1

Performance

—

Structure

3/3

BIM Essentials

3/3

3.3. Layer Intersection Group Numbers
The project makes good use of layer intersection priority numbers throughout all of the
layer combinations. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/127880/

Impact Multiplier

5

Performance

—

Structure

2/3

BIM Essentials

2/3

3.4. Layer Extensions
Not all of the layers use extensions. Consider using extensions for all layers as they aid
in identification and sorting.
Reference: https://helpcenter.graphisoft.com/user-guide/128976/

Impact Multiplier

1

3.5. Number of Layers
Total number of Layers in the Project: 60
The project has less than 100 layers which is considered a good amount. No action
needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/127877/
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Performance

3/3

Structure

3/3

BIM Essentials

—

Impact Multiplier

3

3.6. Elements on the "Archicad" Layer
Number of elements on the Archicad Layer in Floor Plans: 0
There are no elements in the plan viewpoints that reside on the Archicad layer. No
action needs to be taken.
The Archicad Layer is a special Layer that cannot be deleted, hidden or renamed, so
elements should reside on their own dedicated layer, not the Archicad layer.
Reference: https://helpcenter.graphisoft.com/user-guide/127877/

Performance

—

Structure

3/3

BIM Essentials

3/3

Impact Multiplier

3

Performance

—

Structure

3/3

BIM Essentials

3/3

3.7. Structuring of Layer Combinations
All Layer Combination names follow a consistent and predictable naming convention
and have correct layer settings. Check the wireframe settings of layers as they may need
to be the same in all layer combinations. And check your layer combinations for any
unnecessarily visible layers. Otherwise no action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/127879/

Impact Multiplier

1

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Performance

—

Structure

2/3

BIM Essentials

—

Impact Multiplier

1

3.8. Structuring of Pens & Colors
All/most Pen Sets are in use, all/most pens have a description, and all/most pen sets are
being used. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85471/

3.9. Structuring of Line Type attributes
Some of the default Archicad Line Types might have been overridden. This can make
library parts appear incorrectly. New line types do not follow a consistent and clear
naming convention. Duplicate line types may also exist. Consider reinvoking the default
line types, removing any duplicates and following a clear naming convention.
Reference: https://helpcenter.graphisoft.com/user-guide/127883/

3.10. Structuring of Fill Type attributes
Some of the default Archicad Fill Types might have been overridden. This can make
library parts appear incorrectly. New fill types do not follow a consistent and clear
naming convention. Duplicate fill types may also exist. Consider reinvoking the default fill
types, removing any duplicates and following a clear naming convention.
Reference: https://helpcenter.graphisoft.com/user-guide/127884/

Performance

—

Structure

2/3

BIM Essentials

—

Impact Multiplier

1

Performance

—

Structure

1/3

BIM Essentials

1/3

3.11. Structuring of Composite Structure attributes
The Composites do not follow a clear naming convention and/or contain many spelling
or grammatical errors. Duplicate composite structures may also exist. Consider
correcting these.
Reference: https://helpcenter.graphisoft.com/user-guide/127886/

Impact Multiplier

1

Performance

—

Structure

1/3

BIM Essentials

1/3

3.12. Structuring of Complex Profile attributes
Complex Profiles do not follow a clear naming convention and/or contain many spelling
or grammatical errors. Duplicate profiles structures may also exist. Consider correcting
these.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85508/
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Impact Multiplier

1

3.13. Structuring of Surface attributes
The default Archicad Surfaces have been left untouched and/or new surfaces follow a
consistent and clear naming convention. No dupolicates or italicized surfaces exist. No
action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85472/

Performance

—

Structure

3/3

BIM Essentials

3/3

Impact Multiplier

1

3.14. Structuring of Building Material attributes
The Building Materials follow a consistent and clear naming convention. No action needs Performance
to be taken.
Structure
Reference: https://helpcenter.graphisoft.com/user-guide/127885/
BIM Essentials
Impact Multiplier

—
3/3
3/3
1

3.15. Structuring of Zone Categories
The Zone Categories follow a consistent and clear naming convention. No action needs
to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128148/

Performance

—

Structure

3/3

BIM Essentials

3/3

Impact Multiplier

1

3.16. Structuring of City attributes
Some of the Cities do not follow a clear naming convention and/or contain some spelling Performance
or grammatical errors. Consider correcting these.
Structure
Reference: https://helpcenter.graphisoft.com/user-guide/127874/
BIM Essentials

—
2/3
—

Impact Multiplier

1

Performance

—

Structure

1/3

BIM Essentials

—

Impact Multiplier

1

3.17. Structuring of Operation Profiles
The Operation Profiles do not follow a clear naming convention and/or contain many
spelling or grammatical errors. Consider correcting these.
Reference: https://helpcenter.graphisoft.com/user-guide/128840/

15

Attribute Management Potential

Auditor Notes
- The layers were well organized, but there were 2 different organizational structures (the default Archicad system,
and a unique system). It is recommended to use a single unified system instead.
- Layer extensions are barely utilized, there are some more opportunities, and it would improve the organization of
the layers
- Intersection group numbers are well utilized, outstanding.

16

4. Project Settings
Project Settings do not greatly affect the performance of the project, but it is good to have settings that make sense
and ease the workflow. The items listed below are more suggestions aimed to improve the Structure than issues
that are detrimental to the health of the project.

4.1. Autogrouping
Edit > Grouping > Autogroup' is Enabled in the project. Consider the need to have this
enabled, especially for the long term. Autogroup should be used with caution, as too
many groups in a project can slow Archicad down.
Reference: https://helpcenter.graphisoft.com/user-guide/128013/

Performance

2/3

Structure

—

BIM Essentials

—

Impact Multiplier

1

4.2. Snap Point Settings
The Snap Points settings (at 'View > Snap Point Options') are in a state that might slow
down pre-selection. If you notice any feedback slowness, consider changing these
settings back to 'Half' and 'Along Entire Element'.
It is recommended to set Snap Points to 'Half' and 'Along Entire Element', because those
require the least processing power. It is not recommended to turn all of these options off
completely though, as they can improve modeling accuracy and speed significantly.
Reference: https://helpcenter.graphisoft.com/user-guide/127969/

Performance

2/3

Structure

—

BIM Essentials

—

Impact Multiplier

1

4.3. Magic Wand Settings
Give Preference to:

Best Match

Tracing Method:
Deviation from Curves (≥40 mm)
The default Archicad Magic Wand Settings have been left untouched, or the new
settings are appropriate. It is okay to change the magic wand settings for certain tasks,
but you should always turn the settings back to avoid acidentally creating an excessive
amount of segments in elements. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/127974/

Performance

3/3

Structure

—

BIM Essentials

—

Impact Multiplier

3

4.4. On-screen View Options
The following On-Screen View Options can slow down Archicad's 2D performance:
Vectorial Hatching, Show Trimming Bodies, and Hidden Morph Geometry. Some of these
are enabled. If you are experiencing slow 2D performance, consider disabling these
options.
Reference: https://helpcenter.graphisoft.com/user-guide/128436/

Performance

2/3

Structure

—

BIM Essentials

—

Impact Multiplier

1

The default Archicad Model View Option Combinations have been left untouched and/or Performance
any new Model View Option Combinations follow a consistent and predictable naming
Structure
convention and appear to have correct settings. No action needs to be taken.
BIM Essentials
Reference: https://helpcenter.graphisoft.com/user-guide/128435/
Impact Multiplier

—

4.5. Structuring of Model View Option Combinations
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3/3
3/3
1

4.6. Model View Option Combinations in use
Number of Model View Option Combinations in use in the Project:

6

Performance

—

Total number of Model View Option Combinations in the Project:

8

Structure

2/3

BIM Essentials

—

Impact Multiplier

3

Percentage of Model View Option Combinations in use out of total: 75%
There are some Model View Option Combinations that are not assigned to views and/or
MISSING Model View Option Combinations are assigned to views. Consider rectifying
these and or deleting unnecessary ones.
Reference: https://helpcenter.graphisoft.com/user-guide/128435/

4.7. Curtain Walls shown in Full Detail in 3D (Model View Options)
Number of Model View Option Combinations with Curtain Walls in Full Detail:

5

Performance

2/3

Total number of Model View Option Combinations in the Project:

8

Structure

—

BIM Essentials

—

Impact Multiplier

1

Percentage out of total:
63%
Showing Curtain Walls in Full (vs. Schematic) detail level can contribute to Archicad
slowing down. There are some Model View Option Combinations with these options
enabled. If you experience slowness, consider the need for these in the Model View
Option Combinations in which they are enabled and adjust if necessary. At least
consider making Curtain Walls show as Schematic in non-publishing Model View Option
Combinations.
Reference: https://helpcenter.graphisoft.com/user-guide/128995/

4.8. Stairs & Railings shown in Full Detail in 3D (Model View Options)
Number of Model View Option Combinations with Stairs & Railings in Full Detail:

7

Performance

1/3

Total number of Model View Option Combinations in the Project:

8

Structure

—

BIM Essentials

—

Impact Multiplier

1

Percentage out of total:
88%
Showing Stairs & Railings as Full (vs. Simplified or Schematic) can contribute to Archicad
slowing down. There are many Model View Option Combinations with these options
enabled. If you experience slowness, consider the need for these in the Model View
Option Combinations in which they are enabled and adjust if necessary. At least
consider making Stairs & Railings show as Schematic in non-publishing Model View
Option Combinations.
Reference: https://helpcenter.graphisoft.com/user-guide/128995/

4.9. Objects shown in Full Detail in 3D (Model View Options)
Number of Model View Option Combinations with taps, handles & knobs in 3D:

6

Performance

2/3

Total number of Model View Option Combinations in the Project:

8

Structure

—

BIM Essentials

—

Impact Multiplier

1

Percentage out of total:
75%
Showing objects in high detail level can slow the model down in the 3D Window,
Sections, Elevations, etc. This is controlled by the "Object and Lamp Detail Level" and
"Accessories in 3D" options, under the 'Miscellaneous settings for Library Parts' tab of
the Model View Options Dialog. There are some Model View Option Combinations with
these options enabled. If you experience slowness, consider the need for these in the
Model View Option Combinations in which they are enabled and adjust if necessary.
Reference: https://helpcenter.graphisoft.com/user-guide/128995/
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4.10. Structuring of Graphic Override Combinations
The default Archicad Graphic Override Combinations have been left untouched and/or
any new Graphic Override Combinations follow a consistent and predictable naming
convention and appear to have correct settings. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128456/

Performance

—

Structure

3/3

BIM Essentials

3/3

Impact Multiplier

1

4.11. Graphic Override Combinations in use
Number of Graphic Override Combinations in use in the Project:

12

Performance

—

Total number of Graphic Override Combinations in the Project:

26

Structure

1/3

BIM Essentials

—

Impact Multiplier

3

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Percentage out of total:
46%
There are many Graphic Override Combinations that are not assigned to views, or views
with No Overrides assigned to them. Consider the need for unused combinations and
delete if necessary. And consider assigning dedicated Graphic Override Combinations
to all views.
Reference: https://helpcenter.graphisoft.com/user-guide/128456/

4.12. Structuring of Graphic Override Rules
The Graphic Override in the project refer to Graphic Override Rules and they have
dedicated pens and surfaces assigned to them. They also have consistent naming
conventions and no (or few) spelling or grammatical errors. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128455/

4.13. Structuring of Renovation Filters
The default Archicad Renovation Filters have been left untouched and/or any new
renovation filters follow a consistent and predictable naming convention and appear to
have correct settings. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128446/

4.14. Renovation Filters in use
Number of Renovation Filters in use in the Project:
Total number of Renovation Filters in the Project:

4
6

Performance

—

Structure

2/3

Percentage of Renovation Filters in use out of total: 67%
BIM Essentials
There are some Renovation Filters that are not assigned to views. Consider the need for Impact Multiplier
these and delete if necessary.
Reference: https://helpcenter.graphisoft.com/user-guide/128446/

—
3

4.15. Structuring of 3D Styles
The default Archicad 3D Styles have been left untouched and/or any new 3D Styles
follow a consistent and predictable naming convention and appear to have correct
settings. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128998/
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Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

4.16. 3D Styles in use
Number of 3D Styles in use in the Project:

2

Performance

—

Total number of 3D Styles in the Project:

13

Structure

1/3

BIM Essentials

—

Impact Multiplier

3

Performance

—

Structure

3/3

BIM Essentials

3/3

Percentage of 3D Styles in use out of total: 15%
There are many 3D Styles that are not assigned to views. Consider the need for these
and delete if necessary.
Reference: https://helpcenter.graphisoft.com/user-guide/128998/

4.17. Renovation Status of Elements
All elements are set to the proper Renovation status. No further actions needed.
Reference: https://helpcenter.graphisoft.com/user-guide/128443/

Impact Multiplier

3

4.18. Structuring of Favorites
The project contains a comprehensive amount of Favorites, with little or no incorrect
settings or grammatical errors and good folder structure.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85479/

Performance

—

Structure

3/3

BIM Essentials

3/3

Impact Multiplier

1

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

4.19. Greyed out Favorites
Number of greyed out Favorites in the project: 0
The project contains no greyed out favorites, so they are all usable. No action needs to
be taken.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85479/

4.20. Structuring of Element Transfer Settings
Element Transfer Settings can make using Favorites and Element Transfer much easier.
The default Archicad Element Transfer Settings have been left untouched and/or any
new Element Transfer Settings follow a consistent and predictable naming convention
and appear to have correct settings. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128012/

Performance

3/3

Structure

—

BIM Essentials

—

Impact Multiplier

1

4.21. Project Info
Number of filled Project Info items: 23
The Project contains many Project Info entries. These entries can be seen in the File
Properties, IFC and BIMx files. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128941/

Performance

—

Structure

3/3

BIM Essentials

3/3

Impact Multiplier

1

Performance

—

4.22. Project Notes
There are no notes present. Project Notes can be used to store useful notes and
comments about the progression of the project. Consider using these more.
Nevertheless, this is an important aspect of Archicad Projects, so make sure to ask your
BIM Consultant about how you can apply this to your project.
Reference: https://helpcenter.graphisoft.com/user-guide/128942/
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Structure
BIM Essentials
Impact Multiplier

—
N/A
1

4.23. Project Preview
There is an appropriate Picture set for the Project Preview. This preview picture appears
in Operating System Previews, and BIMx as the cover photo of the model.
Reference: https://helpcenter.graphisoft.com/user-guide/128943/

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Performance

—

Structure

1/3

BIM Essentials

1/3

Impact Multiplier

3

Performance

—

Structure

1/3

BIM Essentials

1/3

Impact Multiplier

3

4.24. Architect Credits in BIMx
The Architect Credits in BIMx contains a clear Company Logo (with an alpha channel
when applies). The URL exists and is fully qualified (starts with https://), so it will link back
to your webpage, and there is an appropriate Display Text for the URL. No action needs
to be taken. The Architect Credits will be visible in BIMx.
Reference: https://helpcenter.graphisoft.com/user-guide/128944/

4.25. Element ID Management
Number of Elements with duplicate IDs: 2 796
Depending on the desired workflows, giving every element a unique ID can make data
management easier when finding and quantifying elements in schedules. Many of
elements in the project the same IDs. Consider giving every element a unique ID, unless
you implement a system that conflicts with this theory.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85604/

4.26. Structural Function
Number of Elements set to 'Undefined': 6 870
Elements should generally be assigned a Structural Function, especially when
collaborating with Structural Engineers. Structural function should be set to 'LoadBearing Element' or 'Non Load-Bearing Element', but never left as Undefined. There are
many elements with their Structural Function set to 'Undefined'. Consider correcting
these elements. We recommend using a schedule to audit all Undefined elements.
Reference: https://helpcenter.graphisoft.com/user-guide/128888

4.27. Position
Number of Elements set to 'Undefined': 6 870
Elements should generally be assigned a Position, especially when conducting Energy
Evaluation. Position should be set to 'Interior' or 'Exterior', but never left as Undefined.
There are many elements with their Position set to 'Undefined'. Consider correcting
these elements. We recommend using a schedule to audit all Undefined elements.
Reference: https://helpcenter.graphisoft.com/user-guide/128888

Performance

—

Structure

1/3

BIM Essentials

1/3

Impact Multiplier

3

Performance

—

Structure

1/3

BIM Essentials

1/3

Impact Multiplier

5

4.28. Element Classification
Number of Elements set to 'Undefined': 382
Elements should generally be assigned an Element Classification, especially when
collaborating using IFC. Element Classification should be set depending on the type of
element. There are many elements with their Element Classification not assigned.
Consider correcting these elements, and checking that the Element Classification is
assigned correctly to the elements that have been defined. We recommend using a
schedule to audit the Classification value of all elements.
Reference: https://helpcenter.graphisoft.com/user-guide/128888
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4.29. Structuring of Archicad Properties
Template Default Properties and/or custom Archicad Properties are being used by
Performance
elements in the project. They follow a consistent and predictable naming convention and Structure
appear to have correct settings. No action needs to be taken.
BIM Essentials
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85550
Impact Multiplier

—
3/3
3/3
3

4.30. Find & Select Criteria Sets
No Find & Select Criteria are saved in the project. Consider using these to enable easier
finding & selecting of elements.
Nevertheless, this is an important aspect of Archicad Projects, so make sure to ask your
BIM Consultant about how you can apply this to your project.
Reference: https://helpcenter.graphisoft.com/user-guide/127953
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Performance

—

Structure

—

BIM Essentials
Impact Multiplier

N/A
1

Project Settings Potential

Auditor Notes
- There are a large number of items using the same IDs, most of them are actually voming from IFC elements - the
type of the element is entered into the ID field.
- Some beams were classified as Building Element Proxies. Please see if that was intentional, and if there are any
other elements mis-classified
- There are a lot of duplicated IDs, and most of them are coming from IFC MEP Elements. For the native Archicad
Elements, it is recommended to re-assign the IDs, and for the IFC elements, please see if you acn store the element
type in some other field, and use a valid ID in the ID field instead.
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5. Project Preferences
Project Preferences do not greatly affect the performance of the project, but it is good to have preferences that
make sense, give correct results and ease workflow. The items listed below are more suggestions aimed to improve
the Structure than issues that are detrimental to the health of the project.

5.1. Working Units
The project's Working Units are using the template defaults, or match the local
Dimension Standards. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/127873/

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

3

5.2. Dimension Preferences
The project's Dimension Preferences are using the template defaults, or match the local
Dimension Standards. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128969

Performance

—

Structure

3/3

BIM Essentials

3/3

Impact Multiplier
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5

5.3. Dimension Preferences in use
Number of Dimension Preferences in use in the Project:

2

Performance

—

Total number of Dimension Preferences in the Project:

7

Structure

1/3

BIM Essentials

—

Impact Multiplier

5

Percentage of Dimension Preferences in use out of total: 29%
There are many Dimension Standards that are not assigned to views and/or CUSTOM
Dimension Standards are assigned to views. Consider rectifying these and or deleting
unnecessary ones.
Reference: https://helpcenter.graphisoft.com/user-guide/129011/

5.4. Calculation Units & Rules
The Template Default settings have been left in place, or the the new settings are
appropriate. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128970

Project Settings:
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Default Settings:

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

5.5. Conditional Rules
The project either contains no schedules with conditional parameters or the ones
referred to by schedules have the relevant rules check. Conditional Rules are only
applied to schedules that list any 'Conditional' Parameter in their fields (eg. Conditional
Surface on the Outside Area'). No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128970
Project Settings:

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Default Settings:

5.6. Zone Preferences
The project's Zone Preferences are set correctly. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128971

Project Settings:
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Default Settings:

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

5.7. Reference Levels
The The Sea Level (and maybe some Reference Levels) in the project have been
utilized. These can be used to automate annotation in Section and Elevation and with
Level Dimensions. The Sea Level is directly linked to the altitude set in Project Location.
No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128972
Project Settings:

Performance

3/3

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Default Settings:

5.8. Legacy Preferences
Number of Legacy Preferences Enabled: 0
Having Legacy Preferences enabled can indicate that the project is not fully utilizing all
of the latest features. This project has no Legacy Preferences enabled. No action needs
to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128973
Project Settings:
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Default Settings:

Performance

3/3

Structure

3/3

BIM Essentials

—

Impact Multiplier

3

5.9. Stair Rules and Standards
Number of hidden Rules: 0

Performance

0/3

Total number of Rules:
6
Any item that is set to be hidden here will not appear in the Rules & Standards panel of
Stair Settings (provided that the rule is not in use). Having too many shown may indicate
a learning opportunity. Having too many hidden may confuse users. Ask your BIM
consultant about how you could fulfill this missing potential.
Reference: https://helpcenter.graphisoft.com/user-guide/128190

Structure

0/3

Project Settings:

BIM Essentials

—

Impact Multiplier

1

Default Settings:

5.10. Project Location Settings
The Project Location matches and includes the address in Project Info. The Project North Performance
and the Altitude have also been set. No action needs to be taken.
Structure
Reference: https://helpcenter.graphisoft.com/user-guide/127874
BIM Essentials
Impact Multiplier

28

—
3/3
3/3
3

Project Preferences Potential

Auditor Notes
No Additional Notes.
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6. Project Structure
Project Structure relates to the structure of viewpoints from the project map, views from the view map, layouts from
the layout book and publisher sets. A well organized project structure can save a lot of time simply because it is
consistent, predictable and easy to understand and use. For very large projects, excessive layouts can cause
performance issues.

6.1. Structuring of Project Map
The Viewpoints in the project map are organized and grammatically correct. No action
needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/127932/

Performance

3/3

Structure

3/3

BIM Essentials

—

Impact Multiplier

3

6.2. Number of Viewpoints
Number of Stories:

7

Performance

3/3

Number of Sections:

3

Structure

3/3

Number of Elevations:

4

BIM Essentials

—

Number of Interior Elevations:

4

Impact Multiplier

5

Number of Worksheets:

2

Number of Details:

3

Number of Cameras:

0

Number of Schedules:

23

Number of Project Indexes:

5

Number of 3D Documents:

4

Number of Lists:

54

Total Number of Viewpoints:
109
There are no excess viewpoints. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/127943/

6.3. Viewpoints not derived from 3D model
Number of Independent/Linked Viewpoints:

0

Performance

—

Number of Viewpoints dervied from the 3D model (Auto/Manual rebuild):

109

Structure

3/3

Total number of Viewpoints:

109

BIM Essentials

—

Impact Multiplier

5

The Story structure is sound. Naming is grammatically correct and follows a consistent
Performance
naming convention. Story Heights appear relevant, with no zero height stories. No action Structure
needs to be taken.
BIM Essentials
Reference: https://helpcenter.graphisoft.com/user-guide/128987/
Impact Multiplier

—

Percentage of Independent/Linked out of all Viewpoints:
0%
With the exception of Worksheets and Details, it is recommended to keep all other
viewpoints set to Auto-rebuild Model or Manual-rebuild Model so that the model can be
rebuilt and updated at any time. Except in special scenarios, this indicates a good
workflow. All these viewpoints in the project are set correctly. No action needs to be
taken.
Reference: https://helpcenter.graphisoft.com/user-guide/127943/

6.4. Story Settings

30

3/3
3/3
3

6.5. Section Settings
All (or most) Sections are set correctly. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/129130/

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

6.6. Elevation Settings
All (or most) Elevations are set correctly. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/129130/

6.7. Interior Elevation Settings
All Interior Elevations are set correctly. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/129131/

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

6.8. Worksheet Settings
All Worksheets are set correctly. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/129132/

6.9. Detail Settings
All Details are set correctly. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/129132/

6.10. 3D Document settings
All 3D Documents are set correctly. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128996/

6.11. Camera and Path Settings
There are some issues with the settings of Cameras and/or Paths. Cameras are only
required for Fly throughs and Gallery Views for BIMx publisher sets. You can also use
them as sources for 3D Views, but keep in mind that you can save 3D Views without
using cameras. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/129139/
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Performance

2/3

Structure

—

BIM Essentials

—

Impact Multiplier

1

6.12. Schedule Settings
Many of the Schedule Scheme settings have one or all of the following potential issues:
No criteria to omit elements, incorrect criteria, incorrect sorting, lack of summation. Some
listed Archicad Property fields might also have been deleted from the project, thus
becoming "MISSING" in the scheme settings. Consider addressing these potential
issues.
Reference: https://helpcenter.graphisoft.com/user-guide/129009/

Performance

—

Structure

1/3

BIM Essentials

—

Impact Multiplier

5

Performance

—

6.13. Project Index Settings
Project indexes were not utilized in your project, but it could be ok in the current project
stage. Nevertheless, this is an important aspect of Archicad Projects, so make sure to
ask your BIM Consultant about how you can apply this to your project.
Reference: https://helpcenter.graphisoft.com/user-guide/128433/

Structure

N/A

BIM Essentials

—

Impact Multiplier

1

6.14. Shadow Casting in 2D Viewpoints
Number of Viewpoints with shadows applied:

4

Total number of Sections, (Interior) Elevations & 3D Documents:

15

Percentage of Viewpoints with shadows out of the total:
27%
There are some views with Shadow Casting enabled. Shadow Casting takes time for
Archicad to calculate. Ensure shadows are only used for presentation purposes, and not
turned on in Viewpoints that you only use for editing. If you start experiencing slow
rebuild times consider disabling them until it comes time to publish.
Reference: https://helpcenter.graphisoft.com/user-guide/129130/

Performance

2/3

Structure

—

BIM Essentials

—

Impact Multiplier

5

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

5

Performance

—

Structure

2/3

BIM Essentials

2/3

6.15. Structuring of View Map
The View Map is structured well into folders that match the Layout Book. There are no
grammatical errors. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/127933/

6.16. Views in Clone folders
Number of Views in cloned folders:
Total number of Views:

14
66

Percentage of Views in cloned folders out of the total: 21%
The project contains a some clones, but it could use more. Clones are encouraged for
views that are considered to represent the final status of a project.
Reference: https://helpcenter.graphisoft.com/user-guide/127944/

Impact Multiplier

3

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

6.17. View Settings
Number of views with custom/missing settings: 0
There are no MISSING/CUSTOM settings in View Settings, all views in the project are set
appropriately. No action needs to be taken.
When a Settings Combination or Preset is deleted from the project, the associated Views
might not be able to reference it anymore, and it becomes MISSING. This can cause
serious differences in the intended and actual output of Views. Similarly, if a
Preset/Combination was not saved before applying it to a View, then it will reference a
CUSTOM combination, which is unmanagable.
Reference: https://helpcenter.graphisoft.com/user-guide/129011/
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6.18. Structuring of Layout Book
The Layout Book is structured well into subsets and numbering is correct. There are no
grammatical errors. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85596/

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

5

6.19. Number of Layouts
Number of Layouts in Layout Book: 26
There are less than 150 layouts in the project. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128638/

Performance

3/3

Structure

—

BIM Essentials

—

Impact Multiplier

5

6.20. Layout IDs inherited from Subsets
All layouts get their ID from Subsets/Layout Book. This is desirable to automate layout
numbering. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/129125/

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

3

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

1

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

3

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

3

6.21. Drawing Name by Source View Name
All drawings get their Name from the View Map. This is desirable so that when the name
of the view changes, the name of the drawing will change accordingly. No action needs
to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/129125/

6.22. Drawing IDs inherited from Layout
All drawings get their ID from the Layouts and all are included in the drawing ID
sequence. This is desirable to automate drawing numbering. No action needs to be
taken.
Reference: https://helpcenter.graphisoft.com/user-guide/129125/

6.23. Drawing Settings
All (or most) drawings appear to have consistent and robust settings. No action needs to
be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/129125/

6.24. Drawings stored in the project file
Number of Drawings stored in the project file:

1

Performance

2/3

Total number of Drawings:

2

Structure

2/3

BIM Essentials

—

Impact Multiplier

3

Percentage of stored Drawings out of total:
50%
Drawings that have the 'Store Drawing in the Project File’ option checked, means that
the generated drawings are each stored in the file as a collection of lines, fills and text.
These can greatly increase project file size. The project has some of it's drawings with
this setting checked. Consider reviewing these.
Reference: https://helpcenter.graphisoft.com/troubleshooting/performance/filesize/#Layout_data
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6.25. Unused Master Layouts
Number of unused Master Layouts:

2

Performance

2/3

Total number of Master Layouts:

7

Structure

2/3

Percentage of unused Master Layouts out of total: 29%
BIM Essentials
There are some unused Master Layouts. Unused Master Layouts can sometimes indicate Impact Multiplier
a redundancy and can add extra unnecessary size to the project. It is a good idea to
keep any that be required in the future. Consider the need for these.
Reference: https://helpcenter.graphisoft.com/user-guide/128628/

—
3

6.26. Linked Drawings on Master Layouts
Number of Linked Drawings placed on Master Layouts: 0
The project contains no linked drawings on master layouts. It can be a good choice to
make the Title Blocks on Independent worksheets and place them on layouts as linked
drawings, but be careful how many of these you link. Drawings, Title Blocks & Logos that
are linked onto Master Layouts can increase unnecessary overheads, considering these
items do not change often. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/128628/

Performance

3/3

Structure

3/3

BIM Essentials

—

Impact Multiplier

5

Performance

—

Structure

3/3

BIM Essentials

—

Impact Multiplier

5

Performance

—

Structure

3/3

BIM Essentials

3/3

6.27. Autotexts
The Master Layouts make good use of Autotext. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85593/

6.28. Structuring of Publisher Sets
Publisher Sets are structured well (with no grammatical errors) and its functions are well
utilized. No action needs to be taken.
Reference: https://helpcenter.graphisoft.com/user-guide/127946/

Impact Multiplier

5

6.29. Shortcut folders in Publisher Sets
Number of Publisher Set items in shortcut folders:
Total number of Publisher Set items:

144
181

Percentage of items in shortcut folders out of total: 80%
Most of the Publisher Sets were created using shortcuts. It is recommended to use as
many shortcuts for building up the Publisher Sets as possbile, because placing Views
and Layouts in the Sets manually may lead to unexpected or missing information.
Consider recreating these by using shortcuts.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85603/
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Performance
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BIM Essentials
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Impact Multiplier
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6.30. Architect Credits in BIMx Publisher Set
The 'Use Architect Credits in BIMx Hyper-models' checkbox is checked in all of your
BIMx Publisher Sets. No action needs to be taken. The Architect Credits can be viewed
in BIMx.
Reference: https://helpcenter.graphisoft.com/knowledgebase/72763/
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6.31. Info Sets in BIMx Publisher Set
The 'Info Set' is set to Classification and Properties in most of your BIMx Publisher Sets.
Performance
This already contains plenty of useful information, but this way you have very little control Structure
over what information will be displayed. Consider selecting a schedule for these.
BIM Essentials
Reference: https://helpcenter.graphisoft.com/knowledgebase/44264/
Impact Multiplier
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—
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Project Structure Potential

Auditor Notes
- All Drawing IDs are inherited from the source views, which is good and consistent behavior. But some views don't
have IDs, and so the drawing doesn't have an ID either.
- Not many views were using clone folders, but it could improve the speed of the documentation workflows.
- Some Dimension settings were custom, and some Renovation Filters are missing.
- Shadow casting on 3D derived 2D viewpoints are well utilized - only the Elevations have them turned on, it is not
turned on on technical drawings unnecessarily.
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7. External Content
The way external content is managed affects all three foundations of a project: Size, Speed and Structure.
Eliminating redundant data or embedded it can solve a lot of issues.

7.1. Internal Drawings
Number of missing internal drawings: 3
Some internal drawings are missing. Make sure to relink or delete these drawings as
necessary. Some external drawings may be missing (external drawings are not included
in the checkup). This will need to be checked locally.
Reference: https://helpcenter.graphisoft.com/user-guide/129017/

Performance

2/3

Structure

2/3

BIM Essentials

—

Impact Multiplier

5

7.2. External Drawings
Number of external drawings: 3
The project has some linked files. These may be large in size (without access to them
they can not be assessed in Archicad Project Audit). Consider checking these images
/PDFs / DWGs.
Reference: https://helpcenter.graphisoft.com/user-guide/129017/
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7.3. Hotlink Module Management
Number of hotlinks referenced from PLN files:

0

Performance

N/A

Number of hotlinks referenced from MOD files:

0

Structure

N/A

Number of hotlinks referenced from Teamwork Projects: 0

BIM Essentials

N/A

Number of hotlinks referenced from IFC files:

Impact Multiplier

0

5

Number of hotlinks referenced from 3DM files:
0
There are no Hotlink Modules used in the Project. Nevertheless, this is an important
aspect of Archicad Projects, so make sure to ask your BIM Consultant about how you
can apply them to your project.
Reference: https://helpcenter.graphisoft.com/user-guide/128713/

7.4. XREF Management
Number of XREFs bound to project:

2

Performance

Number of XREFs attached to project: 2
Structure
Some XREFs have been bound (or exploded). Such XREFs can increase the size of the
BIM Essentials
project. Consider the need for this information. Deleting their layers is an effective way of Impact Multiplier
removing the data associated with XREFs. Although removing their Attributes through
Attribute Manager is the only way to remove every trace of them.
Reference: https://helpcenter.graphisoft.com/user-guide-chapter/85673/

2/3
2/3
—
1

7.5. IFC Translators
All of the IFC items in the Publisher Sets are using a Generic Translator. If you only need
a Generic IFC export, because you don't actively collaborate with other disciplines, this
can make sense, but you should consider exporting different IFC files for different
purposes using the appropriate Translators.
Reference: https://helpcenter.graphisoft.com/user-guide/128907/
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Performance

—

Structure

—

BIM Essentials

2/3

Impact Multiplier

5

External Content Potential

Auditor Notes
- The Structural IFC Model item in the Publisher set has no Translator associated with it.
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Summary
Below is a summary of the project's performance. Please keep in mind that this is subjective and
makes assumptions based on typical criteria, which may differ from your office workflows.
Consider the Overall Archicad Project Audit Score a benchmark against other projects or
previous Archicad Project Audits, rather than a typical rating. This report is intended to introduce
you to possible areas to explore to further your Archicad experience. If you are at all concerned
about the evaluation of your project, please contact your local GRAPHISOFT representative.
Thank you for the opportunity to assist you with checking your project.

Overall Scores

Scores by Sections
Overall
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By Category

Overall Score

80%

General Recommendations
While the Archicad Project Audit is extremely thorough in checking Archicad files for Performance, Structure and BIM
Essential issues, there are other reasons why a file may be slow which falls outside the scope of an Archicad Project
Audit. If you are experiencing ongoing problems after making changes suggested in this report, please be aware of
the following.

GRAPHISOFT Help Center
The GRAPHISOFT Help Center is the best resource for any Archicad related help topic.
https://helpcenter.graphisoft.com/

Work Environment Settings
User Preferences Schemes> Advanced Redraw Options> Model Display in 2D Navigation: Adjust if you experience
unexpected feedback during panning.
User Preferences Schemes> Model Rebuild Options> Update Auto-rebuild Model viewpoints continuously: Adjust if
you are trace referencing sections/elevations etc and are experiencing slow rebuild times. (These will need to be
manually rebuilt though).

Hotlinked Modules
Hotlinked modules are mapped locally to your computer or network and as such as not checked in the Archicad
Project Audit. Please be aware that these hotlinks can seriously slow down your project if not managed properly. We
recommend publishing and linking module files (.mod) rather than whole projects.

2D Problems
There are many ways that 2D elements can cause problems in a file, all of which cannot ideally be covered in the
Archicad Project Audit. These include but are not limited to trees and foliage, bitmaps, scale sensitive objects,
objects with requests coded into them, slow-to-regenerate doors and windows, zones interacting with walls and
columns, complex profiles, symbolic vs. projected views, excessive palettes open like the Drawing Manager which
needs to refresh constantly, DirectX problems, hardware optimization, and video card settings.

PhotoRendering Settings
There are many photorendering settings between the Internal, Cinerender and Sketch rendering engines. Sun
shadows, detailed textures, lighting, reflection, physical render scenes, backgrounds, image size, etc all contribute to
lengthy render processing times. Be sure to start with the simple (fast) scenes and tweak the settings slowly, gauging
render times as you progress.

Teamwork
Be sure NOT to treat your BIMcloud (Basic) like it is a file server. Many issues come from keeping too many users
logged into teamwork projects for too long. Keep in mind that Archicad will need to keep track of all those users and
their (potential) changes to the model. This increases the size of the file, sometimes to a point where it is so large it
becomes unusable. This could potentially crash the BIMcloud and jeopardize all of your Teamwork Projects.
Teamwork Projects should only remain on the BIMcloud while they are active. Otherwise they should be saved as an
Archive (.pla) and removed from the BIMcloud.
Also ensure that all libraries come from the same source. If they come from different sources, it will require constant
reloading and this is not the intention. Ideally you should have a folder of libraries that contains all of the relevant
BIMcloud libraries and periodically you or your BIM Manager should make sure all libraries loaded to the BIMcloud
are pathed from the same central folder instead of the AC24 library coming from John’s iMac and the office library
got loaded from Jane’s iMac, etc. You or your BIM Manager should go to the Manage BIMcloud Libraries dialog and
relocate the link to a central folder.
Similarly if you consistently access Teamwork Projects from different locations, don't use the same user to do so.
Create unique user names for each location (eg. Jane - Office & Jane - Home) so that Archicad can handle the two
sets of changes separately.
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Date Settings
On a Mac (only) if the computer's date is not set to the current date some operations can become slow, such as
placing doors and windows.

Preventing Issues
To minimize the likelihood of running into issues, start by making sure your computer specifications meet the
GRAPHISOFT recommended specifications for Archicad as listed at:
https://graphisoft.com/resources-and-support/system-requirements
Regularly turn off your computer to clear the RAM. At least once a day is recommended.
Join the Customer Experience Improvement Program, via the Help menu> Customer Experience... Don’t worry it
doesn't take much data and no personal information is revealed, but it does provide GRAPHISOFT with a lot of
useful information that they can use to continually improve Archicad.
Send any and all Bug Reports to GRAPHISOFT.

Reporting Issues
If you are experiencing ongoing issues that have not been addressed after making suggested adjustments in the
Archicad Project Audit, chances are you have a unique problem that is very specific to your project. In this case the
best solution is to contact your local Archicad Sales Agent at:
http://www.graphisoft.com/info/where_to_buy/
Create a Bug Report whenever Bug Reporter pops up. You have an option to send either anonymous or detailed
report. Detailed reports include specific, limited user data as detailed in our Privacy Notice. This extra information
helps GRAPHISOFT programmers to fix bugs faster and serve you better.

This report can be sent along with a step-by-step description of what symptoms you are experiencing and if possible
what you think may be causing it or leading up to it, including screenshots where necessary. Also upload an
Archicad Archive Project (.pla) to DropBox or a similar file sharing service and provide your local agent with a link to
it.
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